Stylesheet Designer Stylesheet Designer coverts XML documents into HTML without you having to know a single thing about
XSLT programming! The XSLT Stylesheet is automatically created for you! There are only a few steps: Load the Schema
that forms the basis of your HTML document Assign a working XML document which provides preview data Drag and drop
the specific schema elements into Stylesheet Designer window View the results in the integrated Internet Explorer window The
XSLT Stylesheet is automatically created for you! Stylesheet Designer is available in two flavors:As a stand-alone product which
allows you to create XSLT stylesheets As an administration module/tool which allows you to prepare an XSLT Template for
further use with authentic 5. Overview Stylesheet Designer has three main areas: two panes on the left and the main window at
right.The topleft pane displays a tree view of currently loaded schema file. The schema name and path is displayed in the top
line The Text style pane consists of several tabs, and allows you to assign HTML properties to text elements in the main window.
The Block style pane consists of several tables and allows you to assign HTML Properties to blocks, such as tables, in the main
window. The main window is where you design your XSLT template You can also view the automatically generated XSLT
stylesheet and preview the transformation results in Internet Explorer in this window. Symbols and Icons  Stylesheet Designer
uses easily recognizable symbols to display the various schema elements in the tree view, and uses tag symbols for the XSLT
elements is the Design view. Tree view symbols and icons Schema name and folder Document root. All elements inserted from
below the Document root (but not under the Global Templates) into the Design view, become local elements. Any formatting
applied to them in the Design view, only takes effect in this document instance. The Design view tab contains the text Design
[Document] Global templates are defined using the elements under the Global Templates element. Element. Attribute. Element
with child/sub elements. Global templates, these are equivalent to global elements in a schema. Use Global Templates as text
modifiers for the moment e.g. bold, italic or paragraph. Click the global template you want to apply formatting to (italic. in this
case). The Design view now displays the italic. template. The tab also contains the name of the global template Design [italic].
Define the attributes the global element is to have using the TEXT STYLE pane, click on the Text tab and select font-style =
italic. Wherever this element appears (or is applied to) text in Designer view, it will appear in italic Clicking the italic icon in
the title bar in [?] inserts this element and changes the text to italic.) Design view symbols and icons Root element tags. The
(contents)text between the two tags in the Design view, is the symbol for an XML data placeholder. The placeholder is filled
with data when you switch to the IE Preview tab. The data is supplied by the XML file assigned to the schema visible in the tree
view. Use the menu option [?] to assign the XML file to the schema. Click the placeholder and press the keyboard Del. key.
This deletes the placeholder in the Design tab, and causes the XML data to be suppressed in the IE Preview. Click between the
two tags where you want to insert the placeholder. Click right (at the cursor position) to open the context menu, and select Insert
Contents. Start and end tags of the Person element, expanded. The parent tags of the Person element (Altova) are also included.
Person element tag, contracted. To expand or contract tags, double click the specific tag. Manager attribute, start and end tag.
Contents, placeholder for XML data. Person element inserted as a table containing both elements and attributes Email element
"input field". Clicking right on the vertical border at the right allows you to directly change the size of this field by dragging
with the mouse. Place the cursor over any table or cell border, and drag when the mouse pointer changes to the double headed
arrow.The moment you click and drag, the cell or table dimensions appear in a popup allowing you to precisely define its size.
You can also use the same method on table borders that have been hidden, by clicking the View[?], and dragging on the dashed
lines that have then become visible. You can apply formatting (bold etc.) toparts of a table eg. only some of the column headers,
some cells etc., by just marking them and applying bold or any other HTML formatting for example. Using drag left allows you
to mark multiple cells and apply formatting. Clicking an element tag marks the whole element, to which you can then apply the
specific formatting. In the diagram above, clicking the <Altova><Person> element would mark the whole table. (also standard
HTML formatting using the HTML combo box in the title bar??) Designer Tutorial The aim of this tutorial is to create an
XSLT stylesheet for a company which has two offices, the main US office and the EU dependency. The name of the Document,
Orgchart in this case The name of the regional office The address data of each of the regional offices The office departments and
a list of employees in each department with an email address to use as hyperlink.

Note Designer supports unlimited undo, you can always go back and retrace your steps!

Creating an XSL Stylesheet ~ Start Stylesheet Designer by double clicking on the Stylesheet Designer icon.You are presented
with an empty environment. Select the menu option File | Open and open the OrgChart.xsd schema file supplied with Stylesheet
Designer (in the Examples folder). The OrgChart schema is the basis of your stylesheet. The elements and attributes it contains
are used to create the XSLT stylesheet. Select the menu option File | Assign working XML file... and open the OrgChart.xml file
supplied with Stylesheet DesignerThis file supplies the XML data through which you preview the XSLT Stylesheet. The file and
folder name of the XML file now appear in the title bar. Click on the plus icon of OrgChart element in the schema tree view, to
see the sub-elements Click the Name element and drag it into the Design window. Drop it just after the (contents) text to the left
of the root element, end tag. A popup window appears at this point.Click the Create Contents option in the popupThe start and
end tags of the Altova and Name elements are inserted. The (Contents) text, is a placeholder in the Design view and is replaced




by XML data in the IE Preview tab. Click on the IE Preview tab to display the resulting HTML output of the XSLT stylesheet.In
the case the orgchart title is displayedClick the XSLT stylesheet tab to see the automatically generated XSLT code.Click the
Design[Document] tab, to return to the Design view.The XSLT stylesheet can be saved by selecting the menu command File |
Save Generated XSLT file... Select the menu option File | Save as, and enter a name for the file (XSLT-tutorial). The file name
you enter also appears in the title bar.The "Save" command saves the Stylesheet Designer file as a structure file, or template,
(extension *.sps). The .sps file saves all the data visible in the Designer window, as well as the associated working XML and
Schema/DTD files.

Note Only template files (all *.sps files) saved from within Stylesheet Designer, can be edited in authentic 5!

Inserting tables and applying HTML  Click the (Contents) placeholder to mark it.The TEXT BLOCK pane (HTML attributes
window) displays all the HTML attributes available that can be assigned to the element. You might have to drag up the window
divider to see more of the attributes. Click the Text tab, then the font-size combo box and select large. The (contents) placeholder
is updated immediately, and displays the HTML attributes you select. Click to set the text cursor after the Name end tag, and hit
the Enter key.This moves the OrgChart end tag to the next line.Click the plus icon next to the Office element (in the tree view)
to expand the sub-elements.Click the Name element (under the Office element) drag it into the Design view, and drop it in front
of the OrgChart end tag. Select the Create Paragraph item from the popup menu. The start and end tags are now displayed over
three lines. This is the visual indication that a paragraph is to follow each of the XML data instances in the IE PreviewClick
the (contents) placeholder and select medium from the font-size combo box in the TEXT STYLE pane. Click the Color tab in
the TEXT STYLE pane and select red from the color combo box. (Click somewhere else in the Design window to deselect the
contents placeholder).Click the IE Preview tab to see the changes made to the stylesheet.Click the Design [Document] tab to
return to the Design view. Set the text cursor between the Name and Officeend tags. Select the menu option Table | Insert Table.
Define a table of 2 columns and 1 row in the Insert Table dialog box, click OK to confirm the selection.A standard HTML table
is inserted between the two tags.This is a fixed table and does not change with the underlying XML data.Place the text cursor on
the Address tag in the tree view, and drag the Address element into the first cell of the table. Select Create Table from the popup.
This opens the Create dynamic table dialog box. Click the ipo:name entry in the Show columns list box, to deselect it.

Note Stylesheet Designer supports the use of CALS and HTML tables directly in authentic 5 (or in the authentic 5 view of
the IDE). Please see the CALS / HTML table section for more information on how to configure these type of tables for use in
authentic 5.

Click the Table grows... left/right radio button, and confirm with OK.This inserts a dynamic table within the table we just
created. Dynamic tables adjust their size to the underlying XML data.Click in the empty column at the far right, and select the
menu option Insert | Insert Table. Define the table as having 3 rows and 2 columns. Click in the first column (of the new table)
and enter Phone, Fax and E-mail in each row. Click the Phone element in the tree view, drag it into the Design view, and drop
it next to the Phone cell. Select Create Contents from the popup. Use the same method to insert the Fax and Email elements
from the tree view into the respective cells of the table. Select Create Contents in both casesClick the IE Preview tab, to see the
progress so far, then switch back to the Design tab so we can continue designing the OrgchartNot the most beautiful table layout,
I am sure you will agree! Lets try and make it somewhat more pleasing to the eye. Click in the zip cell and select the menu
option Table | Join cell above. Set the text cursor between the state and zip text, and enter a forward slash character (/). Enter
the same character after the ipo:state end tag.Right click the ipo:city tag, and select Change to combo box from the popup menu.
Click the + button, and double click in the Visible Entry field. Enter a city name, e.g. Athens and hit TAB. Enter the text or value
that is to appear in the XML document, hit Enter to confirm. The XML Value can of course differ from the text in the Visible
Entry field. Click the + button again and enter the name of a second city (e.g. Paris). Click OK to confirm these entries and close
the dialog box.

Note To edit the combo box settings: right click the combo box (not the ipo:city tags), and select Edit properties... from the
popup menu.

Click the Address tag at the top of the table, and select the menu option Table | Table properties. Click the border combo box, and
select O from the drop down list, confirm the changes with OK.This removes the table border from the Design view, as well as in
the IE Preview window. The table border is now displayed as a dashed line. This enables you to click the border and resize it if
you wish. Click the View table cell bounds icon to switch the dashed line on or off. Click the IE Preview tab to see the changes,
then click the Design tab so we can complete our orgchart




Note The City combo box entries you define here, can be selected when this template is opened and completed in Document
Editor, the IE Preview displays the currently defined entries. The XML Values defined in the Edit Combo box, are what actually
appear in the template document in Document Editor (in this case 1 for Athens and 2 for Paris).

Note [?][?][?]

Hyperlinking an Image You may want to hyperlink an image to jump to the company’s homepage on the picture. In this case,
we will add a hyperlink to the Nanonull company logo. From the schema tree view pane select CompanyLogo, drag it into the
Design window and drop it in the empty line between the two Name tagsSelect Create Image from the pop-up menu.Select the
Static tag and click the Browse button to select an existing image.Select the picture to insert, in this case nanonull.gif and click
OpenThe selected object is now shown in the Address field. Click OK.The selected picture is now shown at the point of insertion
in the Design view.Click between the CompanyLogo and Name tags, and hit Enter. Right click the inserted image and select
Hyperlink. Write the URL in the Address field, in this case http://www.nanonull.com and click OK

Note You must enter a valid URL, starting with http://. An URL without a prefix can be entered, but the internet connection
would lead to an error message.

Switch from the Design view to the IE Preview and click on the graphic. Internet Explorer searches for the URL and displays the
web site.To go back to the IE Preview, right click and select Back from the pop-up menu

Note See Also[?][?] in the Reference section

Hyperlinking a text At this point we want to hyperlink the company’s name to the Nanonull homepage. Select the text to
use for the hyperlink. In this case, click the Name(contents) placeholder.Click the Insert Hyperlink icon in the menu bar (or
right-click and select Hyperlink from the pop-up menu, shortcut CTRL+K). The Insert Hyperlink window opens. The Selec-
tion: field displays the hyperlink source in your XML document. Select the Static tab and enter a valid URL, in this case
http://www.nanonull.com.Click OK. The hyperlinked selection is now shown with an underline.To check whether the URL is
correct: Switch to the IE Preview tag. Click the Organization Chart hyperlink. Internet Explorer searches for the URL and
displays it.To go back to the IE Preview pane, right-click and select Back from the pop-up menu.

Note See Also:[?][?] in the Reference section

Bookmarks In addition to hyperlinks, you can also define and insert bookmarks. Select the text to use as a bookmark. In this
case, click the (contents) placeholder in the e-mail field. Select the menu option Insert | Bookmark (you can also use the shortcut
CTRL+G). The Insert Bookmark dialog-box opens. The Bookmark name field shows the name of the bookmark. To change the
name, overwrite the text in this field. Click OK to confirm.If several bookmarks exist on the current page, they are shown in the
’Other bookmarks on this page’ list box. Bookmarked text is shown as dashed underlined text. To create a hyperlink from the
company’s name to the bookmarked e-mail address, click the contents placeholder between the Office | Name tags, and then right
click it.Select Hyperlink.Click the Bookmark button. The Select place in Document window opens. Since only one bookmark has
yet been inserted in this document, only this bookmark is shown. Select the bookmark and click the OK button.The bookmark’s
name is inserted into the Address field of the Insert Hyperlink dialog box. Click OK to set the hyperlink.The hyperlink is now
underlined and ready for use. The bookmark (Email) is highlighted with a dashed underline.Switch to the IE preview pane and
click the hyperlink. Since both hyperlink and bookmark are on the same page, you will not see any change (unless you make the
Designer window very small).

Note Bookmark in the Reference section.




Completing the stylesheet Set the text cursor just in front of the Office end tag and hit the Enter key (you can also use the
keyboard arrow keys, to move the cursor in the design view).This inserts a space between the end of the table and the end tags,
and also creates a paragraph in the IE Preview. Click on the Desc tag in the tree view, drag it to the Design view and drop it in
front of the Office end tag. Select Create Contents from the popup menuClick the Para tag in the tree view (expand the Desc.
tag), drag it to the Design view and drop it in front of the Desc end tag. Select Create Paragraph from the popup menu.

Note Inserting the para (graph) tag in Stylesheet Designer, makes it possible to add a new paragraph(s) to the Description text
(using the Enter key) in authentic 5. The para start and end tags, are automatically inserted when the Enter key is pressed in
authentic 5.Deleting paragraphs in authentic 5 is achieved using the Backspace and Del. keys

Click between the Desc and Office end tags, and hit Enter to insert a paragraph.Click the IE Preview tab to see the results, and
then switch back to the Design view. Each company now has its own address data and description text. Click the plus icon next
to the department element to see the sub elements. Click the Name element (of the Department parent element), drag it to the
Design view, and drop it after the Desc end tag. Select Create Paragraph from the popup menu that opens automatically.Place
the text cursor between the Desc end tag and the Department start tag, and hit the Enter key.If you check the IE Preview, you will
see that all the department names have been inserted after the company description text.Click the Department | Name (Contents)
placeholder, and select bold from the font-weight combo box in the Text tab of the Text style pane. Click the (Department)
Person element in the tree view, drag it into the Design view and drop it between the Name and Department end tags. Select
Create Table from the popup menu that opens at this point, and confirm with OK.Click between the Person and Department end
tags, and hit the Enter key. Click the IE Preview tab to see the results, and then return to the Design view.Click in the table header
and select the menu option Table | Table properties... Click the Row tab and select aqua from the bgcolor combo box, click on
OK to confirm. Click in one of the table body cells and use the same method to color the rows yellow. Use the same method to
change the border combo box entry to 0 (zero), in the Table tab.Click the IE Preview tab to see the results, and then save your
work using the File | Save menu entry. Select the menu option File | Save Generated XSLT file... The generated XSLT can now
be used to create HTML output for your XML files. If you want to edit the XSLT file you can open it in *XMLSPY* at any time.

Note See Also[?]

Stylesheet Designer Reference The reference section contains a complete description of all Stylesheet Designer windows and
menu commands. Menus and dialogs This section describes the menu, dialog box and context menu options. File The File
menu contains all commands relevant to manipulating files in the order common to most Windows software products. Open

The Open... command allows you to open an XML schema, DTD or .sps file. The familiar Windows "Open" dialog is opened
and allows you to select one of these file types. You may get an error message if your file is either not well-formed or invalid,
in this case switch to *XMLSPY* and try to resolve the problem there. Opening a .sps file displays the tags in the Design view,
and automatically loads all the XML files associated with this file (Schema/DTD and XML document instance). Save The Save
command saves the currently open Stylesheet Designer file as a structure file. The file type extension is *.sps. The .sps file saves
all the data visible in Stylesheet Designer, as well as the associated XML and Schema/DTD files.

Note Only template files (all *.sps files) saved from within Stylesheet Designer, can be edited in authentic 5!

Save as... The "Save As..." command shows the familiar Windows "Save as..." dialog and prompts for the name and location of
the .sps file to be saved.

Note Only template files (all *.sps files) saved from within Stylesheet Designer, can be edited in authentic 5!

Assign working XML File The Assign working XML file command assigns an existing XML file to the currently open DTD or
schema file. The XML file is used to preview the XSLT file using the XML data. Clicking the IE Preview tab without having
assigned an XML file, opens a message box prompting you to select one.

Note The name and folder of the XML working file is displayed in the title bar of Stylesheet Designer! If a file has not been
assigned, only the *.sps name is displayed.




Save generated XSLT file The Save generated XSLT file command allows you to save the current version of the XSLT file
visible in the XSLT Stylesheet tab. Most recently used files The list of most recently used files, shows the file name and path
information for the nine most recently used files, which you can select with the mouse. To access these files using the keyboard,
press: ALT+F,1 to open the File menu, and select the first file in the list. Exit The "Exit" command is used to quit Stylesheet
Designer. If you have an open file with unsaved changes, you will be prompted to save these changes. Edit The Edit menu
contains the undo and redo commands which allow you to discard or restore your previous actions. Undo Hotkey: CTRL+Z
The Undo command contains support for unlimited levels of Undo! Every action can be undone and it is possible to undo one
command after another. The Undo history is retained after using the "Save" command, enabling you go back to a state the
document was in before you saved your changes. Redo Hotkey: CTRL+Y The Redo command allows you to redo previously
undone commands — thereby giving you a complete history of the work you have completed. You can step back and forward
through this history using the Undo and Redo commands. Select All Selects the entire contents of the Design Document window.
Insert The Insert menu provides commands enabling you to insert various items into the Design view. Paragraph The Paragraph
command encloses the selected element in a paragraph. Image.. The Paragraph command encloses the selected element in a
paragraph. List The List... command inserts a list bullet for each of the elements or attributes. A dialog box opens, allowing
you to specify how many list instances you want to insert. Contents The (contents)text between the two tags is the Design view
symbol for an XML data placeholder. The placeholder is filled with data when you switch to the IE Preview tab. The data is
supplied by the XML file assigned to the currently visible schema visible in the tree view. Use the menu option File | Assign
working XML file... to assign the XML file to the schema. Click between the two tags where you want to insert the placeholder.
Click right (at the cursor position) to open the context menu, and select Insert Contents. The placeholder is inserted at the cursor
position. Click the placeholder and press the keyboard Delete key. This deletes the placeholder in the Design tab, and causes the
XML data to be suppressed in the IE Preview.

Note See Also:[?]

Rest of Contents The Insert Rest of Contents item inserts the unused child elements (of the current parent) at the cursor position.
This option only applies to elements, attributes are not inserted. The unused child elements are those child elements (of the
current parent element) that occur in the schema, but have not been inserted in the Design Document window. The placeholder
is filled with data when you switch to the IE Preview tab. The data is supplied by the XML file assigned to the currently visible
schema visible in the tree view. Use the menu option File | Assign working XML file... to assign the XML file to the schema.
Click between the two tags where you want to insert the placeholder. Click right (at the cursor position) to open the context
menu, and select Insert Rest of Contents. The placeholder is inserted at the cursor position. Click the placeholder and press the
keyboard Delete key. This deletes the placeholder in the Design tab, and causes the XML data to be suppressed in the IE Preview.
Bookmark The "Bookmark" command allows you to define a bookmark from an element in Stylesheet Designer. Double click
the text (free standing or table header text) from where you want to start. Go to the Menu bar, click Insert and select Insert
Bookmark (or use the shortcut CTRL+G).The name of the bookmark is shown in the Bookmark name field. You can change it to
a name of your choice. If there are more bookmarks on the same page, they are displayed in the Other bookmarks on this page
window. Click OK. The bookmark has been set.

Note See also:[?] in the Tutorial section.

Hyperlink The "Insert Hyperlink" command/icon allows you to define a hypertext link from an element in Stylesheet Designer.
Click the text (free standing or table header text) from where you want to start. Click the Hyperlink icon in the title bar. Select
the Static tab. Enter the address you want to navigate to e.g. http://www.altova.com Click the IE Preview tab, and then click
the header to jump to the link destination. The Altova home page now appears in the IE Preview window. To go back to the IE
preview pane, right-click and select Back. A hyperlink or bookmark element (or group) can be both a hyperlink and a bookmark.
They are however, single level structures, it is not possible to create a hyperlink inside a hyperlink, or a bookmark inside a
bookmark. You can either select the Static, Dynamic, or Static and Dynamic tab in the Insert Hyperlink window. A hyperlink
entered in the Static tab Address field remains fixed. The Absolute Path check box does not have to be selected. The Dynamic
and Static and Dynamic tabs, allow you to use XPath notation to select addresses for hyperlinks. In this tab, you can select
theAbsolute Path checkbox. you can check the Absolute XPath checkbox. In this case, the resulting Xpath is absolute rather
then relative (default setting). If you select the Static and Dynamic tab you can link to two Static and one Dynamic address. If a
hyperlink has already been inserted, right-click and select Edit hyperlink.

Note See also:[?][?]




Bullets and Numbering... The Bullets and Numbering command allows you to change the type of bullet or numbering graphic
for the currently selected list or list item. The Numbering command changes the paragraph to a numbered list and back again.
The numbers are automatically incremented if you add more paragraphs. Clicking this icon always inserts the default numbering
- digits starting with 1. This is only possible when using the para tab.Right click the para tab which should have auto numbering
Select Change to List. This inserts a bullet in front of the contents placeholder. Click the contents placeholder, and click the
Numbering icon in the title bar. This changes the bullet to a number.Opening the document in authentic 5 and hitting the Enter
key while in the para tab, automatically adds a new paragraph with correct auto numbering sequence. The symbols used for
bullets and numbering can be changed using the menu option Properties | Bullets and numbering. The changes made in this
dialog box only apply to the currently selected list or list item. The Bullets command changes the paragraph to an unordered
bulleted list and back again. Bullets are automatically inserted if you add more paragraphs. Clicking this icon always inserts
the default bullet - a solid round bullet. The symbols used for bullets and numbering can be changed using the menu option
Properties | Bullets and numbering. The changes made in this dialog box only apply to the currently selected list or list item.
Table The Table menu provides commands enabling you to change table characteristics; append, insert, delete and join rows and
columns. The table commands available to you depend on the type of table and the current cursor position. To prepare for the
insertion of CALS or HTML tables in Document Editor, please see the CALS / HTML Table properties section. You must have
previously inserted a table using the Insert | Table menu command (a fixed table), or Dragged an element into the Design window
and selected Create Table from the popup menu (a dynamic table). Click in a table cell and select the specific command from
the menu or toolbar. Use the keyboard Tab as well as the arrow keys, to navigate the table cells. Text can be entered in any
table cell, this includes the table headers as well. Insert Table... The Insert Table... command inserts an empty table into the
design tab. A dialog box opens allowing you to define the size of the table. The inserted table is of a fixed type and does not
automatically change size with varying XML data in the IE Preview. To insert a dynamic table please see the section Context
menus | Create... context menu | Create table. Delete table The Delete table command deletes the currently active table. Append
row The Append row command appends a row to the end of the currently active table. Append column The Append column
command appends a column to the end of the currently active table. Insert row The Insert row command inserts a row above the
current cursor position in the currently active table. Insert Column The Insert column command inserts a column to the left of
the current cursor position in the currently active table. Delete row The Delete row command deletes the row where the cursor is
currently positioned. Delete column The Delete column command deletes the column where the cursor is currently positioned.
Join cell left The Join cell left command joins the current cell (current cursor position) with the cell to the left. The tabs of
both cells remain in the new cell, the column headers remain unchanged. Join cell right The Join cell right command joins the
current cell (current cursor position) with the cell to the right. The tabs of both cells remain in the new cell, the column headers
remain unchanged. Join cell below The Join cell below command joins the current cell (current cursor position) with the cell
below. The tabs of both cells remain in the new cell, the column headers remain unchanged. Join cell above The Join cell above
command joins the current cell (current cursor position) with the cell above. The tabs of both cells remain in the new cell, the
column headers remain unchanged. Split cell Horizontally The Split cell Horizontally command creates a new cell to the right of
the currently active cell. The size of both cells, is now the same as the original cell. Split cell Vertically The Split cell Vertically
command creates a new cell below the currently active cell. Cell content alignment These commands allow you to format the
cell content of individual cells in a table. Align Top This command aligns the cell contents to the top of the cell. Center vertically
This command centers the cell contents. Cell bottom This command aligns the cell contents to the bottom of the cell. View Cell
Bounds This command displays or hides table boundaries in the Design [Document] tab. Set the table border to O (zero) in the
Table Properties dialog box, in the Table tab. Click the View table cell bounds icon.This switches the dashed table borders of
all tables on or off.This method allows you to see hidden table borders and easily change the table size using the mouse Move
the mouse pointer over the dashed line, until the double-headed arrow appears, then click and drag the mouse. A popup appears
showing the dimensions while you drag the mouse. Table properties The Table properties command opens the Table Properties
dialog box. This allows you to customize your table. Authentic The Authentic menu allows you to define special settings for
further processing of the resulting HTML document with the authentic 5. These settings only apply when using the authentic
5! Node Settings.. The Node Settings... command allows you to define the properties of each node i.e. element/attribute in the
Design view, for further processing in authentic 5. Click a node start or end tag (element/attribute tag). Select the menu option
authentic 5 | Node Settings... (or right click the tag and select Editor Node settings... from the popup menu). Note: You have to
click a tag to be able to edit the node settings, clicking the (Contents) placeholder does not make this possible. This check box
lets you define if the XML content of this node can be edited in the authentic 5. This group lets you define if existing child nodes
are to be added, when you add this node in the authentic 5. This group lets you define if, and how, you want to see the markup
tags in the authentic 5. Text entered in this text box, appears as a tool tip hint when the mouse pointer is placed over the node
in the authentic 5. Use this text box to enter explanatory text or hints on how the document is to be filled in. E.g. The Office
node could have the explanatory text, Enter the office name here! Text State icons The Text State icons command allows you to
define an icon for each global element (that can contain text) present in the schema. A global element is one that appears under
the "Global Templates" element in the schema tree view. You have total freedom to apply any styles, formatting etc. to XML
documents using this command. Make sure the element type you want to define as an icon is available as a global element in the




schema (italic). The entry will be visible under Global Templates in the schema tree view in Stylesheet Designer. Click the italic
element under Global Templates, and define the attributes you want it to have in the Text style window e.g. font-style = italic.
Select the menu option Authentic | Text State Icons.This opens the Text State Icons dialog box. Click the + button to add a new
line. Click the combo box that is made available at this point. The drop down list contains all the elements that can contain text
in the Global Templates list.Click the italic entry and confirm with Enter. Double click in the icon name column, and enter the
name of the icon that should represent the attribute e.g. italic.bmp, in the authentic 5 toolbarClick OK to confirm. Design the
icon you want to represent italic in your graphic program (as a windows .gif), and give it the same name as entered in the Text
State Icon dialog box (italic.bmp) Place the italic.bmp in the installation folder of *XMLSPY* which is your installation folder
.\sps\Picts. Start authentic 5 and open or create a new template file (*.sps). The italic.bmp icon you defined is now visible in a
toolbar. Mark some text in the authentic 5 and click the italic icon to apply the formatting. CALS / HTML Table properties

This command allows you to define the type of table, CALS or HTML, you want authentic 5 to support when you open the XML
document or sps template there. Stylesheet Designer now supports the use of CALS and HTML tables directly in authentic 5.

Note Please note:Only one of the two table types can be inserted into a Authentic Document view XML document (any number
of fixed and dynamic tables can still be inserted). The table data are saved in the XML file, and have no effect on the sps
template file. You can assign existing XML tags, in your XML document, to the default CALS or HTML tags in the User Defined
column. This allows you to use existing XML tags as CALS or HTML table tags. CALS or HTML tables can only be inserted at
the exact position defined in the assigned schema file.

Prerequisites for CALS or HTML tables: CALS - a DocBook DTD or Schema that supplies the CALS tags HTML - a XHTML.DTD
or Schema that supplies the HTML tags An SPS file template - created in Stylesheet Designer which includes/references these
DTD/Schemas, and also contains the tags, tables, graphics etc. that form the basis of the template. The ..\Examples folder
contains the HTML-OrgChart.sps file seen below, as well as the other necessary files. The sps template file: references the
HTML-OrgChart.xsd schema file (which also imports the HTML-address.xsd file), and uses the HTML-OrgChart.xml as the
working XML file

Note Please Note:The HTML-OrgChart.xsd file includes the HTML table tags under the para tag. This means that HTML tables
can only be inserted within/under a para tag in authentic 5.To add CALS or HTML tables anywhere else in this example, the
schema file would have to be edited. You would have to insert the table, and all table sub tags, under the tag you want to
contain a CALS / HTML table.

To prepare the sps file for inclusion of HTML or CALS tables: Select the menu option Properties | CALS / HTML Tables...Click
the Enable XML tables in authentic 5 check box. Use the Type combo box to select the type of table you want to insert in
authentic 5, HTML in this case. Confirm with OK.The sps template file is now configured. HTML table(s) can be inserted under
the para tag when you use this HTML-OrgChart template.

Note Please note:lf you enter an element name in the User Defined column that does not exist in the schema file associated
with the XML document, the element name will appear in red.

Please see the authentic 5 documentation on how to insert and use the CALS / HTML tables. Assign Template XML file The
Assign Template XML command allows you to define which XML file is to act as a template when you select the File | New menu
option in the authentic 5 and select a template file (*.sps). The file you select can be any XML file and does not have to be the
currently loaded one, but must conform to the schema currently in use. HTML Import The HTML import menu enables you to
convert HTML files to XML, and auto-generate the XML Schema/DTD, XSLT stylesheet, and XML content files. Open HTML
file The Open HTML command allows you to open an HTML file. The familiar Windows Open dialog is opened and allows you
to select the HTML file you want to convert to XML. Having selected the file you want to import, it then appears in the Design
[Document] window. You then drag the elements you want to convert to XML into the schema window at left. Please see the
HTML to XML Migration documentation for further information. Add to Parent Adds the selected item, in the Design window,
as a child item to the currently active element/attribute in the Schema window. Select the XML parent item by clicking it in the
schema window (not necessary if the root element is the only visible element in the schema view). Select the HTML item (e.g.
header or text) you want to define as the child item (in the Design [Document] window), and Select the specific menu item from
the list below. Converts the HTML selection(s) in the Design [Document] window, into an XML element. Converts the HTML




selection(s) in the Design [Document] window, into an XML attribute. Embeds the current HTML selection between an XML
start and XML end tag. Converts the HTML selection (even if the text cursor is only set in a table), into an XML table where all
HTML items are converted into XML elements. Converts the HTML selection (even if the text cursor is only set in a table), into
an XML table where all HTML items are converted into XML attributes. Insert Inserts the selected item, in the Design window,
above the currently active element/attribute in the Schema window. Select/click the XML item above which the element/attribute
is to be inserted in the schema window. Select the HTML item (e.g. header or text) you want to insert and convert to XML, in
theDesign [Document] window. Select the specific menu item from the list below. Converts the HTML selection(s) in the Design
[Document] window, into an XML element. Converts the HTML selection(s) in the Design [Document] window, into an XML
attribute. Embeds the current HTML selection between an XML start and XML end tag. Converts the HTML selection (even if
the text cursor is only set in a table), into an XML table where all HTML items are converted into XML elements. Converts the
HTML selection (even if the text cursor is only set in a table), into an XML table where all HTML items are converted into XML
attributes. Append Appends the selected item, in the Design window, to the currently active element/attribute in the Schema
window. Select an XML item to which the element/attribute is to be appended in the schema window. Select the HTML item
(e.g. header or text) you want to append and convert to XML, in the Design [Document] window. Select the specific menu item
from the list below. Converts the HTML selection(s) in the Design [Document] window, into an XML element. Converts the
HTML selection(s) in the Design [Document] window, into an XML attribute. Embeds the current HTML selection between an
XML start and XML end tag. Converts the HTML selection (even if the text cursor is only set in a table), into an XML table
where all HTML items are converted into XML elements. Converts the HTML selection (even if the text cursor is only set in a
table), into an XML table where all HTML items are converted into XML attributes. Settings... The Settings... command allows
you to define the specific HTML import settings. Allows for inclusion of starting or containing whitespace, or just carriage return
whitespace. Imports empty cells from static HTML tables. Properties The Properties menu allows you to change the properties
of the various objects in Stylesheet Designer. Page... The Page... command allows you to define the current page properties. The
properties defined here take precedence over the individual HTML element settings. Table... The Table properties command
opens the Table Properties dialog box. This allows you to define the specific table properties. Bullets and Numbering... The
Bullets and Numbering command allows you to change the type of bullet or numbering graphic for the currently selected list or
list item. The Numbering command changes the paragraph to a numbered list and back again. The numbers are automatically
incremented if you add more paragraphs. Clicking this icon always inserts the default numbering - digits starting with 1. This
is only possible when using the para tab. Right click the para tab which should have auto numbering Select Change to List.
This inserts a bullet in front of the contents placeholder. Click the contents placeholder, and click the Numbering icon in the
title bar. This changes the bullet to a number. Opening the document in authentic 5 and hitting the Enter key while in the para
tab, automatically adds a new paragraph with correct auto numbering sequence. The symbols used for bullets and numbering
can be changed using the menu option Properties | Bullets and numbering. The changes made in this dialog box only apply
to the currently selected list or list item. The Bullets command changes the paragraph to an unordered bulleted list and back
again. Bullets are automatically inserted if you add more paragraphs. Clicking this icon always inserts the default bullet - a
solid round bullet. The symbols used for bullets and numbering can be changed using the menu option Properties | Bullets and
numbering. The changes made in this dialog box only apply to the currently selected list or list item. Selected object The
Selected object command, opens the dialog box of the specific object you select. This command only becomes active if you
select a combo box, check box or radio button. Tools The Tools command allows you to select the customize option, from
where you can customize Stylesheet Designer. Spelling This command (hotkey Shift+F7) opens the Spelling dialog box, and
automatically starts checking the currently active XML document in this case the OrgChart.sps document. Not in Dictionary:
This text box contains the word that cannot be found in any of the existing dictionaries (default and custom dictionaries). You
can also edit the text here. The word is also highlighted in the XML document. The command buttons become active at this
point and allow you to decide which action to take. Suggestions: This list box displays a list of words that resemble the unknown
word (supplied from all dictionaries). Double clicking a word in this list automatically inserts it in the document and continues
the spell checking process. Ignore once: This command allows you to continue checking the document while ignoring the first
occurrence of the unknown word. The same word will be flagged again if it appears in the document. Ignore all: This command
ignores all instances of the unknown word in the whole document. Add to dictionary: This command adds the unknown word
to the currently active custom dictionary. This is the dictionary containing the check mark in the Custom Dictionaries dialog
box (custom.tlx). Change: This command replaces the currently highlighted word in the XML document, with the selected
word in the Suggestions list box. Change all: This command replaces all occurrences of the currently highlighted word in the
XML document, with the selected word in the Suggestions list box. Recheck: The Recheck button restarts the check from the
beginning of the document. Close: This command closes the Spelling dialog box. Options...: This command is always grayed out
in Stylesheet Designer. Spelling options This command opens the Options dialog box which defines the global spelling checker
options. Always suggest corrections: Activating this option causes suggestions (from all of the dictionaries) to be displayed in
the Suggestions list box. Disabling this option causes no suggestions to be shown. Make corrections only from main dictionary:
Activating this option causes only the default dictionary to be used, none of the custom dictionaries are scanned for suggestions.
It also disables the Custom Dictionaries button, preventing any editing of the custom dictionaries. Ignore words in UPPER case:




Activating this option causes all upper case words to be ignored Ignore words with numbers: Activating this number causes
all words containing numbers to be ignored. Dictionary Language: Use this combo box to select the dictionary language for
the spelling checking. The default installation allows you to select English. Other language dictionaries will be made available
on the Altova download web site. The Custom Dictionaries... button allows you to: Modify Dictionary: modify an existing
dictionary (add or delete dictionary entries) Create Dictionary: create a totally new dictionary Add Dictionary: add an existing
dictionary Remove Dictionary: remove an existing dictionary When you start the spell checking process, all dictionaries listed in
the Custom Dictionaries list box are searched. If you want to limit the search to specific dictionaries, use the Remove command
to delete those you do not want searched. To modifiy Entires: Click the custom dictionary name whose entries you want to
change, and click Modify... This opens the dictionary highlighted in the list box (custom.tlx in this case). A prompt appears if
none of the dictionaries has been selected.Click in the Word: field and enter the new dictionary entry (this automatically activates
the Add button). Click Add to add it to the dictionary. To delete an entry from the dictionary: Click the word in the Dictionary
list box to highlight it, and click Delete. Click OK to confirm the changes made in this dialog box. To add a new dictionary:
Click New, and enter the name of the new custom dictionary in the File name... field. Click Save to save the dictionary. You can
now add entries to the dictionary using the Add button, or the Add to Dictionary button while performing a spell check. To add
an existing dictionary: Use this option to add previously removed (or third party dictionaries). Click Add and select a dictionary
from the list box. Dictionaries have a *.tIx extension. Click Open to add the dictionary to the Custom dictionary list.

Note Please note:lt is not mandatory for a dictionary to have a *.tIx extension. It can have any, or no extension at all, and still
be added to the dictionary list box.

To remove a dictionary: Click the dictionary name in the list and click Remove. This removes the dictionary from the list, it
does not physically delete it from your hard disk. Customize The customize command lets you customize Stylesheet Designer
to suit your personal needs. Commands The Commands tab allows you customize your menus or toolbars. To add a command
to a toolbar or menu Open this dialog using View | Customize. Select the command category in the Categories list box. The
commands available appear in the Commands list box. Click on a command in the commands list box and drag it to an to an
existing menu or toolbar. An I-beam appears when you place the cursor over a valid position to drop the command. Release the
mouse button at the position you want to insert the command. A small button icon appears at the tip of mouse pointer when you
drag a command. The check mark below the pointer means that the command cannot be dropped at the current cursor position.
The check mark disappears wherever it is possible to drop the command (over a tool bar or menu). Placing the cursor over a
menu when dragging, opens it, allowing you to insert the command anywhere in the menu. Commands can be placed in menus
or tool bars. If you created you own toolbar you can populate it with your own commands/icons.

Note Please note:You can also edit the commands in the context menus (right click in Stylesheet Designer opens a context
menu), using the same method. Click the Menu tab and then select the specific context menu from the Context Menus combo
box.

To delete a command or menu: Open this dialog using View | Customize. Click on the menu entry or icon you want to delete, and
drag with the mouse. Release the mouse button whenever the check mark icon appears below the mouse pointer. The command,
or menu item is deleted from the menu or tool bar. Toolbars The Toolbars tab allows you to activate or deactivate specific
toolbars, as well as create your own specialized ones. Stylesheet Designer toolbars contain symbols for the most frequently used
menu commands. For each icon you get a brief tool tip explanation when the mouse cursor is directly over it. The status bar (at
the bottom of the application window) displays a more detailed description of the command. You can drag the toolbars from their
standard position to any location on the screen, where they appear as a floating window. Alternatively you can also dock them to
the left or right edge of the main window. To activate or deactivate a toolbar: Click the check box to activate (or deactivate) the
specific toolbar. To reset the Menu Bar Click the Menu Bar entry and Click the Reset button, to reset the menu commands to the
state they were in when Stylesheet Designer was installed. To reset all toolbar and menu commands Click the Reset All button,
to reset all the toolbar commands to the state they were when Stylesheet Designer was installed. A prompt appears stating that
all toolbars and menus will be reset Show text labels: This option places explanatory text below toolbar icons when activated.
Keyboard The Keyboard tab allows you to define (or change) keyboard shortcuts for any Stylesheet Designer command. To
assign a new Shortcut to a command: Select the commands category using the Category combo box. Select the command
you want to assign a new shortcut to, in the Commands list box Click in the Press New Shortcut Key: text box, and press the
shortcut keys that are to activate the command. The shortcut immediately appears in the text box. If the shortcut was assigned
previously, then that function is displayed below the text box. Click the Assign button to permanently assign the shortcut.The
shortcut now appears in the Current Keys text box.(To clear this text box, press any of the control keys, CTRL, ALT or SHIFT).




To deassign (or delete a shortcut): Click the shortcut you want to delete in the Current Keys list box, and Click the Remove
button (which has now become active). Click the Close button to confirm all the changes made in the Customize dialog box. To
reset all keyboard assignments: Click the Reset All button.A dialog box appears prompting you to confirm if you want to reset
all keyboard assignments. Click Yes if you want to reset all keyboard assignments. Set accelerator for: Currently no function.
Menu The menu tab allows you to customize the main menu bars as well as the context menus (right click anywhere). To
customize a menu: Select the menu bar you want to customize (Default Menu currently). Click the Commands tab, and drag the
commands to the menu bar of your choice. To delete commands from a menu: Click right on the command, or icon representing
the command, and Select the Delete option from the popup menu, OR, Select View | Customize to open the Customize dialog
box, and Drag the command away from the menu, and drop it as soon as the check mark icon appears below the mouse pointer.
To reset either of the menu bars: (Select the Default Menu entry in the combo box) Click the Reset button just below the menu
name. A prompt appears asking if you are sure you want to reset the menu bar. To customize any of the Context menus (right
click menus): Select the context menu from the combo box. Click the Commands tab, and drag the commands to context menu
that is now open. To delete commands from a context menu: Click right on the command, or icon representing the command,
and Select the Delete option from the popup menu. OR, Select View | Customize to open the Customize dialog box, and Drag
the command away from the context menu, and drop it as soon as the check mark icon appears below the mouse pointer. To reset
any of the context menus: Select the context menu from the combo box, and Click the Reset button just below the context menu
name.A prompt appears asking if you are sure you want to reset the context menu. To close a context menu window: Click on
the Close icon at the top right of the title bar, or Click the Close button of the Customize dialog box. Menu animations Select one
of the menu animations from the combo box, if you want animated menus. Menu shadows Click the Menu shadows check box,
if you want all your menus to have shadows. Options The Options tab allows you to set general environment settings. Toolbar
When active, the Show Tool tips on toolbars check box displays a popup when the mouse pointer is placed over an icon in any of
the icon bars. The popup contains a short description of the icon function, as well as the associated keyboard shortcut, if one has
been assigned. The Show shortcut keys in Tool tips check box, allows you to decide if you want to have the shortcut displayed
in the tool tip. When active, the Large icons check box switches between the standard size icons, and larger versions of the
icons. Help The Help menu contains all commands required to get help or more information on Stylesheet Designer, as well as
links to information and support pages on our web server. Stylesheet Designer includes a online help system that is based on the
Microsoft HTML Help Viewer, and let you currently access the table of contents, index and search function of the supplied help
file. The Help menu also contains the Registration dialog, which lets you enter your license key-code, once you have purchased
the product. Table of contents... ~ This command displays a hierarchical representation of all chapters and topics contained in
the online help system. Use this command to jump to the table of contents directly from within Stylesheet Designer. Once the
help window is open, use the three tabs to toggle between the table of contents, index, and search panes. The Favorites tab lets
you bookmark certain pages within the help system. Index... This command accesses the keyword index of Stylesheet Designer
Online Help. You can also use the Index tab in the left pane of the online help system. The index, lists all relevant keywords
and lets you navigate to a topic by double-clicking the respective keyword. If more than one topic matches the selected keyword,
you are presented a list of available topics to choose from. Search... The Search command performs a full-text search in the
entire online help system. Once you enter your search term into the query field and hit the Return key. The online help system
displays a list of available topics that contain the search term you’ve entered. Double-click on any item in the list to display the
corresponding topic Registration... When you start Stylesheet Designer for the first time, you are automatically presented
with the Registration dialog box, which lets you register your software product in order to be eligible for technical support and
activate your license, which is done by entering a unique key-code to unlock the software. FREE Evaluation Version If you have
downloaded the Stylesheet Designer from our web server and would like to activate your FREE 30-day evaluation version, please
enter your name, company, and e-mail address and click on the Request FREE evaluation key... button. Stylesheet Designer then
uses your Internet connection to transmit the information you have just entered to our web server, where a personal unique
evaluation license will be generated for you. The license key-code, which is necessary to unlock your software, will then be sent
to the e-mail address you have entered - it is therefore important, that you enter your real e-mail address in the registration dialog
box! Once you have clicked the request button, please go to your favorite mail software and retrieve the license key-code from
our e-mail message, which you should be receiving in a matter of a few minutes (depending on transient Internet conditions). If
you requested a key-code and it didn’t arrive in a short space of time, the process may have failed due to Firewall restrictions in
your network. If this is the case, please send a short message with your information via e-mail to our website and our support
staff will generate a key-code for you manually. When you have received your evaluation key-code, please enter it into the
key-code field in the registration dialog box and click on OK to start working with Stylesheet Designer. Whenever you want to
place an order for a licensed version of Stylesheet Designer, you can also use the Order license key... button in the registration
dialog box or the Order form menu command to proceed to the Secure Altova Online Shop on the Internet. Licensed Version
If you have purchased a single-user license for Stylesheet Designer, you will receive an e-mail message from us that contains
your license-data and includes your name, company and key-code. Please make sure that you enter all fields from your license
e-mail into the registration dialog box. The key-code will only be able to unlock your software installation, if the entries in the
name and company fields match the name and company entered into our order form. If your company has purchased a multi-user




license for Stylesheet Designer, you will receive an e-mail message from us that contains your license-data and includes your
company name and key-code. Please make sure that you enter the company name and key-code from your license e-mail into
the registration dialog box and also enter your personal name into the name field. The key-code will only be able to unlock your
software installation, if the value in the company field match the company name entered into our order form. Please note that
the Stylesheet Designer License-Agreement does not allow you to install more than the licensed number of copies of Stylesheet
Designer on the computers in your organization (per-seat license). Order form... When you want to place an order for a
licensed version of Stylesheet Designer, use this command or the Order license key... button in the registration dialog to proceed
to the Secure Altova Online Shop on the Internet, where you can choose between different single- and multi-user license packs.
Once you have placed your order, you can choose to pay by credit card, send a check by mail, or use a bank wire transfer.
Support Center... If you have any questions regarding our product, please feel free to use this command to query to our support
center on the Internet at any time. This is the place where you’ll find links to the FAQ, support form, and e-mail addresses for
contacting our support staff directly. FAQ on the web To help you in getting the best support possible, we are providing a list
of Frequently Asked Questions (FAQ) on the Internet, that is constantly updated as our support staff encounters new issues that
are raised by our customers. Please make sure to check the FAQ before contacting our technical support team. This will allow
you to get help more quickly. We regret that we are not able to offer technical support by phone at this time, but our support staff
will typically answer your e-mail incidents within one business day. Components download The Components download option,
currently lets you to download the latest Microsoft XML Parser, as well as an alternate XSLT Transformation System, and will
be expanded in the future Altova on the Internet... This command takes you directly to the Altova web-server [?] where you
can find out about news, product updates and additional offers from the Altova team. Japanese distributor... If you are located
in Japan, you may prefer to contact our Japanese distributor on the Internet by using this menu command. About Stylesheet
Designer This command displays the current Stylesheet Designer splash window and version number. Text style pane The Text
style pane allows you to set attributes for text in your .sps file. You can select the attributes for color, text, position of text, layout,
more and IE by clicking on each tab. Select from the values in the drop-down list of each combo box. Block style pane The
Block style pane allows you to set attributes in areas (e.g. tables) in your .sps file. You can select the attributes for color, text,
position of text, layout, more and IE by clicking on each tab. Select from the values in the drop-down list of each combo box.
Context Menus Context menus are opened by clicking right on some part of the user-interface. The pop-up menu that opens is
determined by where you click. You can customize the context menus using the View | Customize option. Change... context
menu  Right-clicking in the Design view, opens this context menu. If you right-click a tag, you can change the tag into any
one of the other types available in this list. The authentic 5 Document view Node Settings... item, opens a dialog box enabling
you to define the current node properties for further editing in the Authentic Document view. (Node in the Designer view means
an element or attribute tag.)

Note Insert

Create... popup menu  Not exactly a context menu. This menu is automatically opened when you drag an element from the
schema tree view into the Design view pane. It allows you to decide how the schema component is to be used in the XSLT
stylesheet. Create Contents: Selecting Create Contents inserts the respective tags, and displays them in the same line in the
Design tab. The IE Preview tab displays the XML data as text in a single line without delimiters. Create Paragraph: This
command encloses the contents in a paragraph. Selecting Create Paragraph, inserts the respective tags, and displays them over
three lines. The first line contains the start tags, the second the (contents) placeholder, and the third all the end tags. The IE
Preview tab displays the XML data as text, one line for each instance. Create List: Selecting List, inserts the respective tags
and displays them over three lines in the Design view. The first line contains the start tags, the second a bulleted (contents)
placeholder, and the third the end tags. The IE Preview tab displays the XML data as bulleted text, one line for each instance.
Create Image: Selecting image, inserts the image referenced in the image path. Create Input Field: Selecting Input Field inserts
the element/attribute tags with a text box between the start and end tags in the Designer view. The IE Preview displays a text box
for each XML data instance. Input fields can be resized by clicking the right or lower border and dragging. A popup appears
displaying the current dimension. Create Multiline Input Field: Selecting Multiline Input Field inserts the element/attribute tags
with a multiline text box between the start and end tags in the Designer view. The IE Preview displays a multiline textbox with
scroll bar for each XML data instance. Input fields can be resized by clicking the right or lower border and dragging. A popup
appears displaying the current dimension. Create Combo box: Selecting Combo box, allows you to define a combo box and the
values it contains for the element/attribute you insert. A dialog box opens the moment you select the Combo box entry. Click
the Plus button to add a list entry line to the combo box. Double click in the Visible entry column and enter the list entry you
want to appear. Double click in the XML value column to add combo box return values. The visible entry is used as a descriptor,
the XML value is what is actually saved. E.g. Click the Minus button to delete a row from the list entries. Clicking OK inserts
the element/attribute tags with a combo box between the start and end tags in the Design view. The IE Preview tab displays a




Visible entry XML value
Programmer 1
Support 2
Manager 3
Table 1:

combo box for each XML data instance. To reopen this dialog box, click the combo box and select the menu option Properties
| Selected object... Create Check box: A dialog box opens the moment you select the check box entry. To open this dialog box
at a later time right-click the element to change and select Change to Check Box. Click the Plus button to add an entry line to
the Checked values column. Double click in the column and enter the checked value you want to appear. Double click in the
Unchecked value text box to change the unchecked value. The unchecked value represents the unchecked status of a check box,
and is the XML value when unchecked (a check box must always have a distinct state). Click the Minus button to delete a row
from the checked values. Clicking OK inserts the element/attribute tags with a check box between the start and end tags in the
Designer view. The IE Preview displays a check box for each XML data instance. To reopen this dialog box, click the check box
and select the menu option Properties | Selected object... A dialog box opens the moment you select the check box entry. Click
the Plus button to add an entry line to the Checked values column. Double click in the column and enter the Checked value you
want to appear. The checked value is the XML value that represents checked. Click the Minus button to delete a row from the
checked values. Clicking OK inserts the element/attribute tags with a radio button between the start and end tags in the Designer
view. The IE Preview displays a radio button for each XML data instance. To reopen this dialog box, click the radio button and
select the menu option Properties | Selected object... Create Button: Selecting Button inserts the element/attribute tags with a
button named Button text between the start and end tags in the Designer view. The IE Preview displays a button for each XML
data instance. Insert Contents The Insert Contents item only becomes active if you have previously clicked and set the cursor on
text in the Design view, and subsequently right-clicked the cursor at that position. The (contents) placeholder is inserted at the
position of the cursor. The Insert Rest of Contents item works like the Insert Contents item. The (rest of contents) placeholder is
inserted at the cursor position.
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Insert, paragraph for Authentic, 4
Insert, rest of contents, 12
Insert, row, 6

Insert, table, 6

Installation, 10

Internet, 10, 11

J

Japan, 11

Join, cell below, 6
Join, cell left, 6
Join, cell right, 6

K
Key-code, 10
Keyboard, customize, 9

L

License, 10
License-metering, 10
Licensed Version, 10

Line, delete in Authentic, 4
Line, insert for Authentic, 4
List, 5

M

Marking, table data, 1
Menu, Help, 10

Menu, XSLT customized, 10
Menus, 4

Multi-user, 10

N
nihongo, 11
Nippon, 11

Node settings, 6
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Object, settings, 8

Online Shop, 11

Open , 4

Open, recently used files, 5
Options, customize, 10

Order Form, 11

Overview, Stylesheet Designer, |

P

Page, properties, 8

Paragraph, 5

Paragraph, delete in Authentic, 4

Paragraph, enabling for Authentic, 4

Parser download, 11
Placeholder, adding/deleting, 1
Preview, XSLT file, 1
Properties, page, 8

Properties, table, 6, 8

R

Recently used files, open, 5
Redo, 5

Registration, 10

Rest of Contents, 12
RichEdit, 5

Row, append, 6

Row, delete, 6

Row, insert, 6

S

Save, 4

Save as, 4

Save generated XSLT file, 5
Save, as *.sps, |

Search, help, 10

Secure Online Shop, 11
Selected object, 8
Single-user, 10
Spellchecker, 8

Spelling options, 8

Split cell, horizontally, 6
Split cell, vertically, 6

SPS, making CALS/HTML tables available, 7

SPS, XSLT designer format, |
Stylesheet Designer, 1
Stylesheet Designer, Tutorial, 1
Support, 11

Support Center, 11

Symbol types, bullets, 6, 8
Symbol types, numbering, 6, 8
Symbols, 1




Syntax-coloring, 5

T

Table, 6

Table boundaries, 6

Table of contents, 10

Table properties, 6

Table, cell alignment, 6

Table, delete, 6

Table, dynamic, 4

Table, dynamic type, 2

Table, fixed type, 2

Table, formatting, 2

Table, hiding border, 4

Table, insert, 2

Table, insert CALS / HTML table, 7
Table, properties, 2, 4, 8

Table, view border , 6

Tags, |

Technical Support, 11
Template XML, assign, 7
Template, making CALS/HTML tables available, 7
Template, saving XSLT files, |
Text state icons, 6

Text Style, 11

Text, hyperlink, 3

Toolbars, customize, 9

Topic, view on TOC, 10

Tree view, icons, 1

Tutorial, Stylesheet Designer, 1

U

Undo, 5

Undo, history, 5

Unlimited levels of Undo, 5
Unlock, 10

A\
View table cell bounds, 6

w

Web Server, 11

Web Shop, 11
Working XML file, 4

X

XMLSPY, 11

XMLSPY, Authentic, 1

XSLT Transformation System, download, 11
XSLT, preview, 1

XSLT, saving, |
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